F. SPECIAL FEATURES

Search Feature

Where there are a large number of transactions in the All Transactions window,
the Search feature in FECFile can be used to limit the number of transactions
you need to look through. To use this feature:

[& FECfile - [All Transactions]

= I Indwiduals/Organizations }j m 0 @.@ .":, &

Lne# | Name  Reports Date | Amount | Id -
1i(a) Abrame Al Transactions 52002 150.001716
11(z) Ackerm Boja002  250.00 027
11(a) Ackmai Summary Page bsiz002  500.00:611
11(2) Agarwe  Receipts prr2oo1  s0.00 809
11a) Ajamy, Dibursements 17/2001  250.00/988
11(3) ABMY. | nans and other Oblgatons psia002  250.00 603
11(a) Akel Gy D7/2001  100.00 932
11(a) Abett, Recydebin ps/a002  100.00 697
11(z) Abeta  gon Cuter  P42002 250001346
11(2) Akee, [ 17/2001  100.00 961
11(a) Akee, O 5/2002  100.00i847
11(a) Aidrich, Ronald R. 1290/2001  1000.00 043
11(a) Alese, Dominick 11/15/2002  100.00 837
11(z) Apern, Harlan 10/17/2001  50.00:307
11(a) Apem, Haran 06/28/2002 50.00 1164
11(z) Andrew, Raiph 10/17/2001  750.001356
11(z) Andrew, Raiph 10/07/2002  1000.00:396
11(a) Angim, Carmela 10/30/2002  50.001349
11(z) Appel, Richard W. 12/05/2001 25001727
11(a) Archer, Kimi ). 10/17/2001 20.00 401
11(a)  Arking, Carcle 10/05/2001  100.001192
11(z) Amdt, John 10/05/2001  25.004170
11(a) Amold, Thomas 08/02/2002  100.00:223
11(2)  Auqustine, Joseph 09/19/2002  100.00i328
112) Ayer, Lo 10/25/2002  25.00491
11(a) Baley, Angela 10/17/2001  25.001269
11(2)  Baker-Stone, Lori 10/25/2002  75.001637
11(z) Balantne, Faye 08/02/2002  50.00225
11(z) Barbash, Maurice 11/29/2001  100.00 598
11(2) Barden, Lesie 12/05/2001  150.00769
11(a) Bamard, CharkesF. 10/17/2001  50.00:393
11(a) Barton, Alan 11/29/2001 25.00 650
11(a) Baum, John C. 11/15/2001 50.00 1541
11(a) Beal, Kenneth 12/07/2001  50.00:924
11(z)  Beal, Patrca 11/15/2002  50.001802
11(a) Beaukeu, Sue 09/19/2002 75.00 266
11(a) Beedenbender, Patrica 10/25/2002  50.001503
11(z) Beeman, Linda 10/05/2000  25.00:227
11(z) Belng, Celne 10/19/2001  25.00490
11(a) Bemont, H. Michael 10/25/2002  150.00i710
11(z) Bebonga, Paul 10/05/2001  50.001184
11(a) Benander, Dougias 10/25/2002  50.00:489
11(a) Benazzi Robert B. 12/07/2000  50.00/920
11(z) Benjamin, Earl 10/25/2002  30.001629
11(z) Bennett, Austn 10/30/2002  50.00:928
11(a) Bentham, Kendrick 02/27/2002 50.00080
11(a) Bergstedt, Jan-Enc 11/29/2001  250.00'591
11(z) Bennsten, Henry 10/30/2002  50.00:382
11(a)  Rermsten. Richard 125702001 1000.00 1060 b
Search the transactions. YE:07/01/2001 - 12/31/2001

v" From the all transactions window click on the View Menu and select
Search...or simply press the Control and F keys at the same time. This will
open the Search interface.
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Cancel
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v' Enter a text word or phrase and/or a date range. Then click on OK

[& FECfile - [Search Results]

] Fe Edt Vew Window Hep

OB & s PRHOLEES O

Line# | Name Description Date | Amount | Id

11(a) Appel, Richard \ 12/05/2001  25.001727

11(3) Bemsten, Rich 12/27/2001  1000.00 060

11(s) Braun, Richard 10/30/2002  500.00:024

11(z) Hoffman, Richa 10/25/2002  25.00i584

11(a) Hoag, Richard 09/19/2002  100.00 274

11(a) Ketcham, Richa 10/05/2001  500.001162

11(s) Lagnese, Richar 10/21/2002  50.00419

11(a)  Laurenzo, Richz 10/05/2001 25.00 217

11(a) Lippe, Richard 09/19/2002  50.00304

11(s) Magnussen, . 11/15/2000  100.00 565

11(a) Mathews, Richa 12/07/2001 100.00 831

11(a) Oane, Richarc 10/25/2002  100.00495

11(z) Park, Richard § 10/19/2001  50.00 455

11(a) Petriio, Richard 10/25/2002 100.00 541

11(a)  Perie, Richard 10/05/2001  100.00:207

11(s) Richards, Elen 10/25/2002 __ 25.001571 b

Gregon)| |10/19/2001] _25.00}46 e

11(a)  Speisman, Rich: 10/25/2002  50.00i787

Ready YE:07/01/2001 - 12/31/2001

v" The results of the search are displayed in the Search Results window. Note,
the search looks for the text you seek in the Name, description, address, and
memo text. As an example: Greg Schultz, above...lives on Richards Road.

NOTE: Use the resulting transactions as if they were in the
all transactions window. Also, only one search results is
displayed at a time.

Sort Feature

In a window, the user can sort the transactions in a useful order by using the Sort
Function a Follows.
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I Indwiduals/Organzatons E m - 8.@ ‘::, @
Date 5]

Mame  Reports Amount ~
Al Transactions 01/01/2001 8086.89:111

Abrams 10/25/2002  150.00:716

Ackerm  Summary Page 10/30/2002  250.00.027

Ackmal  Receipts 10/25/2002  500.003611

AJAVE  Disbursements 12/07/2001 50.00 809

AJRMY, | qans and other Oblgations 12/17/2001  250.00.988

Ajamy, 10/25/2002  250.00:603

Recydle bin 12/07/2001  100.00 932
10/25/2002  100.00697
09/24/2002  250.00:346
, 12/17/2001  100.00 961
Aicee, Donna 11/15/2002  100.00 847

Audrich, Ronaid R. 12/20/2001  1000.00 043
Alese, Dominick 11/15/2002  100.00:837
Alpem, Harlan 10717/2001 50.00 307
Apem, Harian 06/28/2002 50.00:164

American Hospital Association | Transfer to Affiated SSF 01/26/2001  5000.00 124
22 American Hospital Association | Transfer to Afflated SSF 06/13/2001  5000.00:131
22 American Hospital Association ¢ Transfer to Afflated SSF 10/12/2001  10000.00 410
22 American Hospital Association | Transfer to Affiated SSF 10/19/2001 _20000.00 411
22 American Hospital Association | Transfer to Aff SF 11/06/2001 _5000.00 536/
22 Amencan Hospital Associton f Transfer to Afflated SSF 11/12/2001 500000 537
22 American Hospital Assocition | Transfer to Afflated SSF 11/16/2001  5000.00 706
22 American Hospital Association | Transfer to Afflated SSF 12/10/2001 15000.00 707
22 Amercan Hospital Assocition | Transfer to Afflated SSF 12/20/2001  7000.00 712
22 American Hospital Association | Transfer to Afflated SSF 02/19/2002 10000.00-:108
22 American Hospital Association | Transfer to Afflated SSF  05/20/2002 10000.00:215
22 American Hospital Association | Transfer to Afflated SSF - 0B/12/2002 10000.00 350
22 American Hospital Association | Transfer to Afflated SSF 09/20/2002 10000.00 351
22 American Hospital Association | Transfer to Affiated SSF 10/01/2002 10000.00 404
22 American Hospital Association | Transder to Afflated SSF 10/28/2002  5000.00 853
22 American Hospital Association | Transfer to Afflated SSF 11/08/2002  5000.00 860
22 American Hospital Association | Transfer to Affiated SSF 11/15/2002  5000.00 861
22 American Hospital Association | Transder to Afflated SSF 10/21/2002 10000.00 044
22 American Hospital Association | Transfer to Afflated SSF 12/09/2002  9500.00 063

11(a) Andrew, Ralph 10/17/2001  750.00 356
11(a)  Andrew, Raiph 10/07/2002  1000.00 396
11(a) Angim, Carmela 10/30/2002  50.00:949
11(s) Appel, Richard W. 12/05/2001 25.00.727
11(2)  Archer, Kimi ). 10/17/2001  20.00401
11(a) Arkins, Carcle 10/05/2001  100.00:192
11(a) Amdt, John 10/05/2001 25.00170
11(2)  Amoid, Thomas 08/02/2002  100.00:223
11(a) Augustne, Joseph 09/19/2002  100.007328
11(a) Ayer, Los 10/25/2002 25.00 451
11(3)  Bakey, Angela 10/17/2001  25.00:269
11(a) Baker-Stone, Lori 10252002 75.003637
11(z) Balantne, Faye 0B/02/2002  50.00:225
1103} Rarhash. Maurice 11292001 100.00 508 L
Sort the tems in the active view YE:07/01/2001 - 12/31/2001

v" From any transactions window click on the View Menu and select Sort. ...or
simply press the Control and R keys at the same time. This will open the Sort
interface.

NOTE: Each transaction window can have its sort
preferences set independently. Set up your sour preferences
for each window.

Sort priority |#S| | Sort priority

|Am0unt _v]\g

<Mone>
Line#

=l
|<N0ne> ﬂ Name
=l

|<N0ne>

|<N0ne> Date

Agoregate
Id

0K | Cancel |

Parent
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v' . There are four levels of sorting available. The top box sorts first, then the
second box and so forth

v The options for sorting are shown above, and are from low to high.

Merge Feature

When there are multiple entries for a single unique contributor, you can use the
Merge Function to merge multiple entries into one entry for a unique contributor.
This helps improve tracking and reporting of aggregate totals for contributors.

I8 FECfile - [Receipts]

B it vew window Hep

fEafie&de S

o New Crri+n

= open. Cui+o

Un  Close Ctri+w

11 001
L savess. 001
11 001
11(  Import... 001
115 Import Names... 001
11 001
1P ames oot
11¢ 001
11 Badap.. 001
11(  Check Limits 001
11 001
11f  Vadate Crriew 501
11{  Print Report Cirisshit+p  Joo1
11(  Upboad... 001
11{  update Commitee List 001
11¢ 001
11 Print... Crlep 001
13(  Print Setup. 001
10 prnt preview 001
11 001
11{ 1 DCf11 Versions Dcf 001
1 3 tesTCCM2.DCH 001
ﬂg 3 AUTH.DCE gg:
11{ 4 AUTHLDCH 001
11 001
115 B 2001
11(aju Roche, Mary Ann 10/17/2001
11{a)u Dimon, Leonard 10/17/2001
11(a)u Eberly, James 10/19/2001
11(a)u Messheo, Hedy 10/19/2001
11(a)u Sab, Jack 10/19/2001
11a)u Schulz, Gregary M. 10/19/2001
11(aju McLeod, Christine 10/19/2001
11(z)u Murray, Kevin 10/19/2001
11(z)u Beling, Ceine 10/19/2001
11(aju Santcs, Lee 10/19/2001
11(a)u McNamara, Sharon A 11/15/2001
11(a)u Tanney, Karen 11/15/2001
11(aju Hende, Shary! 11/15/2001
11(z)u Senn, Lamy 11/15/2001
11a)u Polard, Amy 11/29/2001
11(a)u Mier, Victoria 11/29/2001
11(aju Ward, Marguerke 11/29/2001
11(a)u McCabe, Rz 11/29/2001
11(a)u Shafer, David 11/29/2001
11(aju Stoddard, Ruth 11/29/2001
11(a)u Tryon, Clara 11/29/2001
102N Rarton. Aln 11/29/300

Amount | Aggreg... L. P.

5.00

5.00
15.00
20.00
20.00
20.00
20.00
20.00
20.00
20.00
20.00
20.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
25.00
2500

Merges the possbie dupicates in names user-interactively

5.00 66
5.00 01
15.00 25
20.00 46
20.00 68
20,00 23
20.00 45
20.00 01
20.00 19
20.00 05
20.00 17
20.00 65
25.00 03
25.00 52
25.00 64
25.00 70
25.0072
25.00 74
25.0076
25.00 15
25.0017
25.00 19
25.0021
25.0027
25.00 49
25.00 69
25.00 01
25.00 85
25,0097
25.00 45
25.00 49
25.00 59
25.00 61
25.0077
25.00 86
25.00 50
25.00 99
25.00 55
25.00 61
25.00 67
25.00 69
25.00 32
25.0034
25.00 36
25.00 40
25.00 42
25.00 44
25.00 46
25.00 50

YE:07/01/2001 - 12/31/2001

v" From any transactions window click on the File Menu and select Merge

Names. ...This will open the Merge interface.
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Merging possible duplicate name en‘kies

First occurence Fossible duplicate
Last/ Business Name ~ |ENGELFOR CONG RRANE FOR CONGRESS)
First Name ‘ J |
Mame Prefix ‘ J |
MNarne Suffix ‘ J |
Address line1 | |462 CALFORNIARD << | [482 CALIFORNIA RD
Address, line 2 ‘ J |
Oty |BRONKVILLE << | [BRONKVILLE
State | | =l J | New vk =l
Zip | [10708 << [ro708
Employer ‘ J |
Occupation ‘ J |
Save s far & Quit Mertge ﬂ Don't merge
Cancel All Merge ‘ Resetto As itWas |

v' The system shows the first occurrence of a possible duplicate name in the left
column. In the right column it shows the next occurrence of a possible
duplicate.

v'If the right column information is correct you can update the left column by
clicking on the arrowed buttons. The << buttons will update individual data
items. The <<< button replaces all left column data with all the right column
field values.

v' When the left column data is correct, selecting the Merge Button uses the left
column information for the Merge of both.

If the records are not duplicate, select the Don’t Merge button

When you select the Merge button, the following message is shown.

15 You are about to merge the two occurences of ENGEL FOR CONGRESS - 462 CALIFORNIA RD.... Once you

L] complete the operation and save the file, the change cannot be undone. Are you sure? If you cancel, you wil be
taken to the names window. If you select No, merge wil ignore this record and continue to search for other
dupilicates!

Yes No | Cancel |

v" When you select the Merge Button the system provides a notice to confirm the
action. Select Yes, and you are returned to Merge interface, and the next
comparison is shown.

v If you become confused for a given merge transaction, press the reset button
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to return to the start of that transaction. If you desire to stop the whole merge
process select the Cancel All Merge button.

v" When all merges have been processed, the following is shown. It shows the
number of merged names and provides the option to save the changes done.

!E 3 records were merged. Do you want to save the changes now?

0K | Cancel ‘

NOTE: If you select Cancel...All the merge selections are
deselected, and you will have to start over again.

v If, in the middle of the work (you are not completed with the merge process)
but want to save the work so far, press the Save so far and Quit button. You
will keep the merged items. The function can be run again at a later time to
address the additional duplicate names.
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